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NEW AND NOTEWORTHY

ENHANCEMENTS - 2.8.0
General Updates

STS updated the base Eclipse installation to Eclipse Indigo SR1 that comes with full Java IDE
support for Java 7.

Take a look at the details of the Java 7 support:

htto: / /www.eclipse.org/jdt/ui/r3_8 /Java/news/whats-new-java-/.html

The Mylyn version within STS is upgraded to the latest Mylyn release 3.6.2

STS now ships with the latest m2e version 1.0.100 that comes as part of Eclipse Indigo SR1.
The pre—buikaTS packages also contain compatible add-ons for WTP, AIDT and other useful

add-ons.

Since existing Maven projects that were created using previous versions of STS don't work
anymore with the new m2e version, we provide an automatic update for those projects.

STS now defects when you have legacy Maven projects in your workspace and gives you an
opportunity fo migrate them to a version compatible with STS. Some background: the m2eclipse
project released a new version in June, along with the Eclipse Indigo release train. The project
was rebranded as m2e and is now hosted on Eclipse.org. Unfortunately, the project broke
backwards compatibility with this move. At this point, a legacy m2eclipse project in @
workspace that has m2e installed will not compile and will not have any maven functionality

turned on for it.  Simply rightclicking and converting to a Maven project will not work since there
will still be some legacy data in the classpath and project configuration that will cause problems.

Inside of STS, we are providing an easy way of helping users to migrate to the new version of
mZ2e:

1. On startup, STS will search for any legacy Maven projects in the workspace. If any are
found, the following dialog will appear:
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0.0.0 Should convert legacy Maven projects?

1 The following legacy Maven project has been found:
- legacy-maven-2

** This project will not compile until it is upgraded to M2E version 1.0. **
Do you want to upgrade now?

You can choose to upgrade later by going to:
Project -> Configure -> Convert legacy Maven projects...

[ Don't show this dialog again.

| No | | Yes ]

2. Additionally, this dialog will appear whenever a legacy Maven project is imported into
the workspace.

3. If you no longer want this dialog to appear, then you can tick the "Don't show this dialog
again” checkbox.

4. You can manually invoke this operation by selecting a legacy Maven project: Right click
> Configure > Convert legacy Maven Projecs...

valanTuLIcua - ”

Spring Tools >
Convert to Grails Project
. Convert to JavaScript Project...
Properties |

Convert to Plug-in Projects...
Convert to Maven Project
Convert to Aspect] Project

c N/ O Jroouvy U .

Convert legacy Maven projects...

m

Note that after the migration, old launch configurations and some custom settings will no longer
be working.

If o team is working with different versions of STS (for example, some members on STS 2.8.0
and some on STS 2.7.2), care should be taken as once the projects have been migrated to the
latest m2e version, they won't work with the older STS which will still be using the old version of
m2e. In this situation it is recommended that those users on STS 2.8.0 convert the legacy
projects so that they can be worked on but do not commit the updated metadata to a shared
repository [.project/.classpath). In that way the users on the older version of STS will not pick it
up by accident.

STS ships now with the latest vFabric tc Server Developer Edition 2.6.1.
The bundled Maven version got updated to Maven 3.0.3.
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Spring Development Tools

STS 2.8.0 provides support for parsing and validating Spring bean definition files based on
Spring 3.1, including the new profiles feature.

It is now possible to define the active bean profile for a bean config set to enable profile-aware

validation:

<bean id="rootBean" class="pl.TestBean">
Properties for spring31-project-profiles

type filter text

P Resource
Builders
Java Build Path
P Java Code Style
P Java Compiler
> Java Editor
Javadoc Location
PMD
Project Facets
Project References
Refactoring History
Run/Debug Settings
V¥Spring
¥ Beans Support
Dependency Managemen
Web Flow Support
P Task Repository
Task Tags
P Validation
WikiText

Beans Support v v v
|
Config Files
Group Spring bean configuration files:
» L dev profiles="local" [ New..
» (g prod profiles="cloud"
| Edit..
Delete
Edit Spring Beans Config Set
Name: | dev
Profiles: | local
Options:

[Zf Allow bean definitions to get overridden by later definitions

("] Mark references to missing bean definitions as warning only

Select Spring bean configuration files:

[ dev-config.xml
W [@ root-config.xml

®

—

0 errors, 2 warnings, 0 others E

Description

|

1 L

» /A Snrina Prohlems (2 items)

In this example we have two config sefs defined for two different bean profiles. If there is @
validation éjroblem in one of those sets, because a referenced bean is not defined for a specific

profile, ST

will produce an appropriate warning:
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@ root-config.xml 53 @ dev-config.xml

<?xml version="1.0" encoding="UTF-8"?>
- <beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"”
xsi:schemalocation="http://www.springframework.org/schema/beans http://www.springframework.or,

- <bean id="rootBean"” class="pl.TestBean">
& <property name="otherBean" ref="dataBean" />
</bean>

- <beans profile="cloud">
- <bean id="dataBean" class="pl.TestBean">
</bean>
</beans>

</beans>

Source | Namespaces [ Overview[ beans | Beans Graph |

E Console B_u Markers 5393 Progressbl

0 errors, 1 warning, O others

Description 4 Resource Path
¥ (& Spring Problems (1 item)
.1, Referenced bean 'dataBean' not found [config set: spring31-project-profiles/dev] root-config.xml /spring31-project

We also added more advanced hyperlinking for profile-based bean definitions. When a bean is
defined inside multiple profiles, the Spring Config Editor now shows multiple hyperlinks so user
can select the correct bean to navigate fo.

<bean id="accountRepository" class="com.bank.repository.internal.JdbcAccountRepository">
<constructor-arg ref="dataSource"/>
</bean>

Navigate to dataSource in profile "dev" - transfer-service-config.xml

<bean id="feePolicy" class| Navigateto dataSourcein profile "production” - transfer-service-config.xml

<beans profile="dev">
<jdbc:embedded-database id="dataSource'">
<jdbc:script location="classpath:com/bank/config/sql/schema.sql"/>
<jdbc:script location="classpath:com/bank/config/sql/test-data.sql"/>
</jdbc:embedded-database>
</beans>

<beans profile="production">
<jee:jndi-lookup id="dataSource" jndi-name="java:comp/env/jdbc/datasource"/>
</beans>
</beans>

STS 2.8.0 adds support for the new c-namespace introduced in Spring 3.1

(hitp: / /static.springsource.org/spring/docs /3. 1 .x/springframework-
reference/html/beans. himl#beans-cnamespace.
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Content assist has been added for cnamespace parameter names, as well as for refvalues.
Editor validation will quickly inform you if your constructor has the right number of parameters, or
if your parameter names are unrecognized. Bean ID refactorings will be picked up by ¢
namespace refvalues as well.

X *exml 83 ‘ =08
1 <?xml version="1.8" encoding="UTF-8"7>
2= <beans xmlns="http://www.springframework.org/schema/beans"
3 xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
4 xmlns:c="http://www.springframework.org/schema/c"
5 xsi:schemalocation="http://www.springframework.org/schema/beans http://www.springframework.
6
7 <bean id="bar" class="x.y.Bar" />
8 <bean id="baz" class="x.y.Baz" />
9
10& <bean id="foo" class="x.y.Foo" >
11 <constructor-arg ref="bar" />
12 <constructor-arg ref="baz" />
13 <constructor-arg value="foo@bar.com" />
14 </bean> =
15
@16 <bean id="new-foo" class="x.y.Foo" c:bar-ref="bar" c:t’>
17 @ c:bar - Foo(Bar bar, Baz baz, String email)
. es.c c:bar-ref - Foo(Bar bar, Baz baz, String email)
Source [ Namespaces I Overviewl beans] Beans Graph] @ c:baz - Foo(Bar bar, Baz baz, String email)
m Foojava X | ! & cemail - Foo(Bar bar, Baz baz, String email)
% package X.y; es.c c:email-ref - Foo(Bar bar, Baz baz, String email)
3 public class Foo {
4
5€ public Foo(Bar bar, Baz baz) {
6
7 }
8
9= public Foo(Bar bar, Baz baz, String email) {
10
11 }

There was a problem running Spring Roo on top of JDK 1.7.0. While this got fixed in Roo for
the upcoming 1.2.0.M1 version of Roo, we managed to fix this within STS as well, so that you
can novv| not only run Spring Roo 1.2.0.M1 on top of JDK 1.7.0, but also the latest Spring Roo
1.1.5 release.
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In this milestone we added asyoutype validation and quick fixes for the name attribute in @
constructorarg element. A waming [yellow) line appears under a name attribute that does not
match with any constructor parameter names, and Ctrl+1 brings up a list of possible parameter
names fo rename to.

= <bean name="bean" class="com.springsource.test.Foo">
i <constructor-arg name="barz" value="abc" />
</bean>

|& iChange to 'bar’ in Foo(String bar):

</beans>

Groovy Eclipse

Per workspace compiler selection — via command line argument

Groovy-Eclipse now makes it easier to support multiple compiler levels on one installation. To
specify a compiler level on the command line, add arguments:

sts <OTHER ARGUMENTS> -groovy.compiler.level 18
(For Groovy 1.8.2. Use -groovy.compiler.level 17 for Groovy 1.7.10.)

It is possible to launch two workspaces simultaneously that use different compiler levels if they are
specified on the command line.  Note that you must explicitly install Groovy 1.8.2 from the
update site or the STS dashboard. For more information, please see the docs.

http:/ /docs.codehaus.org/display/ GROOVY /Compiler+Switching+within+Groovy-
Eclipse#CompilerSwitchingwithinGroovy-Eclipse-Specifyingcompilerlevelonthecommandline

Groovy EcliEse now has Groovy 1.8.2 available as an optional install. See the compiler
switching link above for more information on this.

The Groovy-Eclipse configurator for m2e (http://www.eclipse.org/m2e] is now available from
the Groovy-Eclipse update site:

http:/ /dist.springsource.org/snapshot/GRECLIPSE /e3.7

This configurator supports m2e version 1.0 and provides first class support for your Maven and
Groovy project.  This configurator supports both GMaven and the groovy-eclipse-compiler.  For
more information on Groovy-Eclipse's maven support see the docs:
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http:

docs.codehaus.org/display/GROOVY /Groovy-Eclipse+compiler+plugin+for+Maven

Recent improvements in the groovy-eclipse-compiler plugin for Maven include:

Uses Groovy 1.8.2 by default (can be configured to use 1.7.10)

The Java compiler is now Java 7 based (from Eclipse 3.7.1)

No longer need fo use the build helper plugin to specify the src/main/groovy and
src/test/ groovy source folders. They are oddec?oufomoﬂco“y to the build if they exist.

Updated  groovy-eclipse-compiler archetype project. This archetype is available at:
https: //nexus.codehaus.org/ content/ repositories /snapshots

It is now possible to configure Groovy-Eclipse to automatically remove trailing whitespace and
semi-colons on filesave. Go to Preferences > Groovy > Save actions fo enable it:

i®00 Preferences

type filter text Save Actions

»Ceneral
> Ant
Aspect) Compiler
Atlassian Connector
vGroovy
Compiler
»Debugger
DSLD
Editor
Formatter
> Crails
Inferencing Sugges

»Help

[2] Remove unnecessary semicolons

It is also necessary to enable save actions for Java editors, which you can do can do by going
to Preferences > Java > Editor > Save actions:

e 00 Preferences
save Save Actions
¥Ceneral
Workspace .
vGroovy @ Perform the selected actions on save
Save Actions || Format source code
Vlava *) Format all lines
VEditor . :
Format edited lines
, ,
¥JavaScript Configure the formatter settings on the Formatts
VEditor [2] Organize imports
Save Actions Configure the organize imports settings on the ¢

|| Additional actions

« Add final modifier to private fields

« Add missing '@Override' annotations

« Add missing '@Override' annotations to imj
+ Add missing '@Deprecated’ annotations

* Remove unnecessary casts
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Enabling the save action will convert this file:

1

2

a 3=def x = "Help me";
4 x << " more stuff" H
5 println x |

into this file:

1
2

A 3=def x = "Help me"
4 X << " more stuff"
5 println x|

We have added many small enhancements with the Groovy-Eclipse inferencing engine. A list of
all inferencing issues addressed is available here.

http://jira.codehaus.org/secure/IssueNavigator.jspa@reset=true&iglQuery=project+%3D+CGRE
CUPSE+AND-+fixVersion+%3D+17434+AND+component+%3D+%2 2Inferencing+Engine% 22+
AND+status+in+%2 8Resolved%2C+Closed%29+ORDER+BY+priority+DESC

Here are some highlights:
Support for multiple declaration statements

Now, multiple declaration statements are correctly inferred:

idef (xs Y) = [1: 2]'
xl

{5’ Integer x - STS280M2.run()
Type inferencing of DGM methods with non-collection arguments

Now, when non-collections types are targets of DGM methods, the iterator variable type is
correctly inferred:

1.each {"

¥ ‘$ Integer it - STS280M2.run()

€) springsou

A division of VITIWaAre'



Type inferencing for match operators

The =~ and ==~ operators now have appropriate inferencing:
1= (" ==~ /pattern/).booleanValue()"
2 (" =~ /pattern/).hasGroup()

Boolean org.codehaus.groovy.runtime.DefaultGroovyMethods.hasGroup(Matcher matcher)
Spread-dot type inferencing
The spread-dot operator is now correctly handled by the inferencing engine:

[x:1,y:2,z:3]*.key[2].toLowerCase() °
[x:1,y:2,z:3]*.value[@].intValue()

N
‘ Mmeger java.util.Map.Entry.getValue()

We are continuing to improve on our DSL support in Groovy-Eclipse through our DSL descriptors.
Below are the significant enhancements.

Named parameter content assist

Methods that expect named parameters (Iypico||1/1 specified in a DSL descriptor) can have their
named parameters filled in via confent assist, as shown in this screenshot:

class Person { }°

‘

Person. create(])

© age : __ - Integer : named parameter : (Person DSL)
© firstName : __ - String : named parameter : (Person DSL)
© lastName : __ - String : named parameter : (Person DSL)

&° create(String firstName, String lastName, Integer age) : Person - Person (Person DSL)

Notice in the screenshot that there are 3 named parameters displayed: firstName, lastName,
and age. These are defined in a DSL descriptor in the project.

(http:/ /blog.springsource.com/2011/05 /08 /better-dslsupportin-groovy-eclipse/)

As with selecting method proposals during content assist, Groowy-Eclipse will try to find
reasonable values to fill in when selecting a named parameter:

def first.=."Joe'"
def last -=-'Schmoe'"

def -age =-99°

Person.create(firstName: [, D
© first
O last
null
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NEW AND NOTEWORTHY

There is a caveat. Named parameter proposals will not appear in the proposal list if there is a
prefix already tﬁped. So, in the following example, there will be no named parameters
proposed since the prefix 'f' already exists:

def first.=-"Joe'"
def - last.-=-'Schmoe’
def age =99
Person.create(f)"
: © first :

namedParams and optionalParams for method contributions

It is now possible to distinguish between regular, named, and optional parameters in DSLD
method contributions. Regular parameters are always filled in when performing content assist for
the method and they are not prefixed by a name. Named parameters are prefixed by a name
and are also always filled in during content assist. Their position is after all the regular
parameters.  Finally, optional parameters are not filled in via confent assist of the method.
Instead, optional parameters are only available for content assist of named parameters. Al
parameters are visible during hovers.

An example should make this clear. Consider the following simple DSLD file that add editing
support for the static 'create’ method to the Person class:
currentType ("Person") .accept {
method name:"create", type:"Person", params:[id:Long],
namedParams: [firstName:String, lastName:String],
optionalParams: [age:Integer],
isStatic:true, provider:"Person DSL"
}

The method contribution defines params, namedParams, and optionalParams.  The first thing fo
see is that when doing confent assist, only the regular and named parameters will be shown:

Perso;.g'
’ &’ create(Long id, String firstName, String lastName) : Person - Person (Person DSL)

And when applying that proposal, only those parameters are displayed (the first parameter is
regular, and the second two are named):

def first.=."Joe'"

def -last = "Schmoe'"

def -age =-99°

Person.create(fl, firstName:[first, lastName:llast)f

The optional parameters are shown in hovers (along with all other parameters):

der -age = YY"
Person.iggfte(e, firstName:first, lastName:last)®

son Person.create(Long id, String firstName, String lastName, Integer age)
Provided by Person DSL
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They can also be seen in content assist, when named parameters would be visible:

I i ) @ >idzoum,
Person.create(d, firstName:first, lastName:last, D' 1

© age : __ - Integer : named parameter : (Person DSL)
& create(Long id, String firstName, String lastName) : Person - Person (Person DSL)

& S mmnin/Ceriy

Note that the editor is smart enou?h to only show parameter proposals if that parameter doesn't
already exist, so if we remove the lastName named parameter and do content assist, it will show
up as a proposal:

aer-age = 99"
Person.create(®, firstName:first, 'D' II
1 © age : __ - Integer : named parameter : (Person DSL)

© lastName : __ - String : named parameter : (Person DSL)

&° create(Long id, String firstName, String lastName) : Person - Person (Person DSL)

This version of Groovy-Eclipse ships with an experimental way to perform static type checking on
your Groovy projects.  There is a new menu category that appears whenever any Groovy files,
packages, or projects are selected:

Restore from Local History... Il
Groovy Type Checking > Type check
Spring Tools [ 2

> Remove checks
4

Groovy

When invoking this command, all groovy files currently selected will be type checked [i.e., sent
fo the inferencing engine). Warning markers are added fo any expressions that would be
otherwise underlined in the editor:

A 1= def x-= "Some string"*
2
3 print x.substring(2)’
@ 4 print x.oops’

5 . .
| & [Type of expression is statically unknown: oops‘

bt ‘

If you want to remove all of the trpe check warnings simply select "Remove checks" from the
'Groovy Type Checking" menu while selecting the files you want to clean.

You can also add some type assertions to ensure that the static type of an expression is correctly
defermined by the inferencing engine [(this is particularly useful for festing your DSLs):

o 1= def-x-=-"Some string"
Z L

print x.substring(2)"

print x.pops’

g

def yyyy = x.substring(9)
yyyy //TYPE:java.lang.String
yyyy.-//TYPE:com. foo.0Oops

~NoOwv AW

oo

o

& Invalid inferred type. Expected: com.foo.Oops Actual: java.lang.String |
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This feature is still experimental and we are looking for feedback on it. It you find this feature
useful, if you have any suggestions for it, or if you have found problems with it, please contact us
on the STS forum to discuss.

http:

forum.springsource.org/forumdisplay.php?32-SpringSource-Tool-Suite

There is now another way to extend Groovy-Eclipse's inferencing engine. Using quick assists
and a preferences page, users can now contribute dynamic properties and methods to existing
classes for a customized editing experience.

As seen in the image below it is now possible to invoke a Quick-Assist (CTRLT or CMD-1 on
macs) in order to invoke the suggestions dialog. In this example, an unresolved property called
getContentDescription in the declaring type java.util. Arraylist is referenced in a Groovy script.
The user then presses CTRL+1 on the editor selection and can add the property via the "Add

Groovy suggestion" quick assist.

§ Java - groovyprojecttwoysrc/cont groov) (e A
File Edit Source Refactor Navigate Search Project Run Window Help
C3y: SO F-O0-%&-Qv BTBEHECGY BSOS SO

Sivilvrtoova v

o 00 @

f# Package Explorer &2 . Ju JUnit|
& groovyprojectthree
& groovyprojecttwo

@ src

& content
[& Script.groovy

=\ JRE System Library [JavaSE-1.6]

=\ Groovy Libraries

=\ Groovy DSL Support

& .groovy

& .settings

% .classpath

X .project

=0\

selele |l

- “ArrayList prop

a age content

prop.getContentDescription

Add Groovy suggestion
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The Groovy Suggestions dialogue then opens, pre-populated with values related to the current
selection, like the declaring type, property name and type:

"}.‘:‘:"f! ringSource Tool Suite

File Edit Source Refactor Navigate Search Project Run Window Help

S~ O B-0-% Q- BBHEG~ SO~ & vj
12 Package Explorer & _Ju JUnit “ O)( [ Script.groovy £ j R
@ @|B@) « || package content Groovy Inferencing Suggestion
& groovyprojectthree = -ArrayList prop — : :
& groowproj prop.getContentDescription || Add a Groovy Inferencing Suggestion
@ src
& content Name: bexComemDesclimion
[# Scriptgroovy

= JRE System Library [JavaSE-1.6] Declaring Type: Jjava.util ArrayList

=\ Groovy Libraries

Type: Jjavalang.String
=\ Groovy DSL Support
& groovy | Is static
& settings Q) Property () Method
% .classpath
® project | Name

Use named arguments

Doc:

<

£/ Problems @ Javadoc @ Declaration &
Workspace Log

type filter text

Maccans Plun-in Nate

The user can add additional information like doc hovers, or change the suggestion from a
property to a method and add parameters.

Once the dialogue is closed, the suggestion is added to the Groovy Inferencing engine and the
property will now be resolved. The user can add further suggestions, edit or remove existing
ones, in the Preferences > Groovy > Inferencing preferences page. Additionally, a user can
activate or deactivate a suggestion by clicking a check box. Deactivating a suggestion does not
remove the suggestion from the list of suggestions for the project, but any references for that
suggestion Willgbe unresolved until the user activates it again.
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“'Jm- criptgroovy - Spri te
Run Window Help

File Edit Source Refactor Navigate Search Project
e O HB-O~-A%vQ~ BTWHEG~

BSOS PO b

2 Package Explorer 3 . Ju JUnit “ 0)(@ Scriptgroovy &
@ |2 » ©|] package content AWS Toolkit -
& groovyprojectthree = “ArrayList prop _— Data Managemen'
& groovyprojecttwo prop.getContentDescription Groovy
@ src Compiler
& content Debugger
(8 Scriptgroovy DSLD
=\ JRE System Library [JavaSE-1.6 B Editor
=\ Groovy Libraries Formatter
=\ Groovy DSL Support Grails
& groovy Inferencing
& settings Save Actions
X classpath Help
X project Install/Update =/
Java
Java EE
Java Persistence
JavaScript
JDT Weaving
Maven
Plug-in Developm
Profiling and Logg |
Remote Systems
Run/Debug
Server
Spring
SWTBot Preferenc:
Tasks 2
« 7"""“ »

«
(£ Problems| @ Javadoc [ Declaration & ¢
Workspace Log

type filter text

Inferencing
Select a project to manage the Groovy inferencing suggestions.
Project: |groovyprojecttwo v

Deactivate, remove, edit, or add a type suggestion:

Suggestions Edit
W java.util ArrayList
|| getContentDescription : java.lang.String

(Deselect Al
Collapse All | |

[ Expana au | [F

|Restore Delauls] [

;]ok C

3 gs CTR

Suggestions are persisted in the /.groovy,/suggestions.xdsl file at the root of all Groovy projects.

Each Groovy project has it's own

suggestions.xdsl and so they can be persisted in version control for the project. As of M2, this
feature only supports edits of this file through the preference page or suggestions dialogue.

Manual edits of the file are not yet supported.
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The suggestions dialogue performs type validation where appropriate, as seen in the following
screen shot:

Groovy Inferencing Suggestion

: ® value (Declaring Type): The specified Java type(s) does not exist: java.util. ArrayListT
| I
/| Name: getContentDescription

Declaring Type: Jjavauutil. ArrayListT Bro

10 ;

Type: java.lang.String Browse.

[ Is static
(©) Property @ Method

Name Type Add
index int
nameList java.util.List<java.lang.String>

Remove

[] Use named arguments

Doc:

@ o) (e

s ————————————————— —

Any suggestions added to a project that are active also appear in content assist, as seen below
where getContentDescription appears as an option in content assist:

§ Java - groovy c/co Cript.groo gSot t
File Edit Source Refactor Navigate Search Project Run Window Help

HvHRBE (@ -0~ ~-Q~y BTWHECG~Y SO A/~ iy~ iged o

"2 Package Explorer 2 °\_Ju JUnit| = B]([&2se ovy i3 . &) Dashboard |
2B« ~ package content
& groovyprojectthree “RrrayList prop
& groovyprojecttwo prop- N
&3 src o getContentDescription : String - ArrayList (User) S
# content o elementData : Object(] - ArrayList (Groovy) S
[8) Script.groovy © empty : boolean - ArrayList (Groovy)
=i JRE System Library [JavaSE-1.6] o modCount : int - AbstractList (Groovy)
=4 Groovy Libraries o size : int - ArrayList (Groovy)
=\ Groovy DSL Support @ add(Object arg0) : boolean - ArrayList (Groovy)
& .groovy @ add(int arg0, Object argl) : void - ArrayList (Groovy)
?’ settings @ addAll(Collection arg0) : boolean - ArrayList (Groovy)
‘1\1 .clas_spath @ addAll(int arg0, Collection argl) : boolean - ArrayList (Groc
& .project @ clear() : void - ArrayList (Groovy)
° choneO : Object - ArrayList (Groovy) ‘ Y
< ] »

Press 'Ctrl+Space’ to show Template Proposals
J
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Default Groovy Methods now have better inferencing inside of associated closure blocks. For
example, the unique DGM method now supports inferencing of the parameter on its closure:

class Simple { int val }
[new Simple(), new Simple()].unique {
.val|

}

In addition to unique all methods inside the DefaultGroovyMethods class now support inferencing
on parameters in closures where possible. A complete list is available in:

http://jira.codehaus.org/browse/GRECLIPSE-1143.

These classes are now handled just like DefaultGroovyMethods in terms of content assist, hovers,
and navigation. For example:

XmlGroovyMethods:
import org.w3c.dom.NodelList
def method2(NodelList ) {
.iterator()
}

@ Iterator<Node> org.codehaus.groovy.runtime.XmlGroovyMethods.iterator(NodeList nodeList)

ProcessGroovyMethods:

def method2(Process p) {
p.consumeProcessOutput
} © consumeProcessOutput() : void - ProcessGroovyMethods (Category: ProcessGroovyMethods)
@ consumeProcessOutput(Appendable output, Appendable error) : void - ProcessGroovyMethods (Cat
@ consumeProcessOutput(OutputStream output, OutputStream error) : void - ProcessGroovyMethods
@ consumeProcessOutputStream(Appendable output) : Thread - ProcessGroovyMethods (Category: Pr
@ consumeProcessOutputStream(OutputStream output) : Thread - ProcessGroovyMethods (Category:

For more information, see GRECLIPSE-1131, GRECLIPSE-1143, GRECLIPSE-1145, GRECLIPSE-
1153, GRECLIPSE-1154 and GRECLIPSE-1155.

The types of variables assigned in mulﬂ-ossi?nmem‘ statements are discovered during inferencing.
For example, when ossig[;ning a list to multiple variables, the static type of the list elements will be
assigned to each variable:

class Simple { int val }
class Simple2 { int val2 }

idef (x, y) = [new Simple(), new Simple2()]

x.val
y.val2
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Also, when a method returns a list or array, the type parameter or component type is used as the
type of the assigned variable:

class Simple { int val }

JList<Simple> method () {
return [new Simple(), new Simple()]
}

def (x, y) = method()
x.va|
y.val

Match operator expressions now support inferencing:

(" =~ /pattern/).hasGroup()
(""" ==~ /pattern/).booleanValue()

For more information, see GRECLIPSE-1159.

Groovy-Eclipse now follows the DT model of displaying context information for methods when
invoking confent assist inside of a method call and there is no prefix.

For example, when invoking content assist just affer an opening paren, you are only shown a list
of known ways to invoke the target method:

def doSomething(int a, int b, int c = 9) { }
def doSomething(String first, String second = "") { }

doSomething()|
© doSomething(String first) : Object - Script (Groovy)
@ doSomething(int a, int b) : Object - Script (Groovy)
@ doSomething(String first, String second) : Object - Script (Groovy)
@ doSomething(int a, int b, int ¢) : Object - Script (Groovy)

Selecting one of the proposals will show that methods information in tooltips above the caret
location:

String first, String second |

doSomething(

Similarly, invoking content assist after a comma will show context information as well:

doSomething("", )
© doSomething(String first) : Object - Script (Groovy)
@ doSomething(int a, int b) : Object - Script (Groovy)
@ doSomething(String first, String second) : Object - Script (Groovy)
@ doSomething(int a, int b, int ¢) : Object - Script (Croovy)
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For more information, see GRECLIPSE-674.

When a field has a closure for an initializer, content assist will now reflect this and show method
proposal variants for the field:

class ClosureClass {
def field = { String str, int num -> print str + num }

}

new ClosureClass().field
o field : Object - ClosureClass (Groovy)
@ field(String str, int num) : Object - ClosureClass (Groovy)

For more information, see GRECLIPSE-1139.

Import statements are now properly cleaned up affer a move or copy of a Groovy file to a new

location. See GRECLIPSE-682 for more information.

The number of parameters of method declarations are now used to help more precisely
defermine the actual declaration of a method reference:

class LotsOfMethods {
def meth() { }
def meth(int a) { }
def meth(String a, LotsOfMethods b) { }

= new LotsOfMethods().meth()

new LotsOfMethods().meth}(1)
new LotsOfMethods().meth("", null)

See GRECLIPSE-1138 for more information.

This new technique for method searching is used to ensure that overloaded methods do not
interfere with rename refactoring:

[5] Script.groovy 2 942 R

Original Source Refactored Source
38 class LotsOfMethods { 38 class LotsOfMethods { £
39 def meth() { } 39 def meth() { }
49 def meth(int a) { } |—{48 def meth_renamed(int a) { }
41 def meth(String a, LotsOfMethods b) { } 41 def meth(String a, LotsOfMethods b) { }
42 } 42 }
43 new LotsOfMethods().meth() 43 new LotsOfMethods().meth() —
44 new LotsOfMethods().meth(1) | 44 new LotsOfMethods().meth_renamed(1) ]m‘:’
45 new LotsOfMethods().meth("", null) | 45 new LotsOfMethods().meth("", null) |4

« ¢ —5 > « ¢ — >
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Scripts that are not placed on the build path now provide many of the standard editing features
that is used by scripts on the build path, such as content assist, type inferencing, and mark
occurrences. The classpath for the script is assumed fo be the same build path as the one for the
rest of the project.

Note that missing import references will not be reported, and references in scripts will not show

in search results, nor will refactoring work in these files.

Crails Development Tools

STS 2.8.0 now supports Grails 2.0.0.M2 and has been tested with snapshot builds leading up

fo the notyetreleased 2.0.0.RC1.

The Grails project explorer view has been cleaned-up:

* A new icon added for grailsapp/utils
* Default ordering of elements improved based on user suggestions

The default view is now like this:

- Project Explorer 52

4
4
4
4
4
4

vvVvvvVvvVv«wvVvvvwv

v 2 gTunes

€2 domain

(©¥ controllers

&4 views

<0> taglib

LS services

of utils

% scripts

@ i18n

53 conf

(8 src/java

(8 src/groovy

(8 test/unit

(8 test/integration
<= plugins

=), classpath
application.properties
& lib

(= target
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The order of elements in the Grails Project Explorer is now a ?|obo| workspace preference that

can be changed via Windows > Preferences > Groovy > Grails > Project Explorer:

[ : 4| Project Explorer v -
v Groovy E
Compiler Order: €2 domain ‘ ‘
D Debugger @© controllers ]
DSLD || &4 views ‘7‘
Editor <0> taglib
Formatter L& services
v Grails of utils
Grails Launch % scripts
GSP Templates @ i18n
Refactoring (8 src/java
Inferencing Sugges (8 src/groovy
Save Actions # test/unit
D Help (8 test/integration
P Install/Update | [] testreports
D Java <= plugins
D Java EE =) classpath
P Java Persistence |Z) application.properties
D JavaScript
JDT Weaving
P Maven
b Mylyn & | Restore Defaults | | Apply |
(<] i [ [>]
@ ‘ Cancel l [ OK ]

»)

Default permgen size for Grails commands launched from STS has been raised to 192m
(previously 96m).

The default VM launch arguments for running Grails commands are now:

-server -Xmx512M -XX:MaxPermSize=192m

Note that the arguments are only provided by STS if they are not already set by the existing run-
app or festapp launch configuration.

Existing launch configurations and their custom vm arguments can be inspected and changed via
the "Run" menu under: Run > Run Configurations > Grails see the Arguments tab.

Crails 2.0 uses ANSI control characters to make output look nicer on the command line.
Unfortunately, Eclipse Console View does not support this. This makes the Grails 2.0 output not

look as nice inside STS. For example, look at the screenshot below and note the repeated status
messages:
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.VE Console 23 & Markers.‘ﬁaProgress‘ % % G 5@ = i =8

<terminated> gTuneé (create-domain-class Album) [Grails Command] /usr/lib/jvm/java-6-sun-1.6.0.26/bin/java (2!

Loading Grails 2.0.0.M2

Configuring classpath

Configuring classpath.

Environment set to development

Environment set to development.

Environment set to development..

Environment set to development...

Environment set to development....

Environment set to development.....

Created file grails-app/domain/gtunes/Album.groovy
Compiling 1 source files

Compiling 1 source files.

Compiling 1 source files..

Compiling 1 source files...

Compiling 1 source files....

Compiling 1 source files.....

Created file test/unit/gtunes/AlbumTests.groovy

[ m ]

v

STS now includes an output transformer that attempts to prettify this output. The screenshot below
shows what Grails 2.0 output looks like with the output transformer activated:

E console 83 . [2L Markers‘ﬁaProgress‘ % % | G BB = gy =0
<terminated> gTunes (create-domain-class Song) [Grails Command] /usr/lib/jvm/java-6-sun-1.6.0.26/bin/java (20
Loading Grails 2.0.0.M2 =
Configuring classpath.

Environment set to development.....

Created file grails-app/domain/gtunes/Song.groovy

Compiling 1 source files.....

Created file test/unit/gtunes/SongTests.groovy

I m D]

Should you wish to disable the output transformer for some reason, it can be found on the Grails
launch preferences page:

Preferences X

[tvpe fiter text 4] crails Launch 1l e
< Groovy [A]

Compiler System properties to be passed to the Grails process
P Debugger variable value |
DSLD [l =
Editor ‘ Edit ‘

Formatter -
< Grails ‘7‘

GSP Templates ||

Project Explorer [C] Keep external Grails running

Refactoring |Cleanup Grails 2.0 Output
Inferencing Sugges
Save Actions Grails Command Timeout [ms]: [s0000 |
b Help Grails Command Output Limit [chars]: l 200000 ]
D Install/Update
b _Java e [Restore Defaults || apply |
(€] n [ DJ

@ | cancer || oK |
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Renaming of Views and Actions

A Crails aware rename participant is friggered when a controller action method or field is
renamed. (In Grails 2.0 and later, controllers actions can be defined as methods or fields.)

It performs the following kind of changes in addition to a normal Java method or field rename:

* find and rename references in g:link tags in GSP files in the same project. E.g

<g:link controller="song" action="1list">

* render and redirect method calls in controller classes E.g

render (view: "list" ...)

* rename the corresponding view (gsp file). E.g.

rename views/song/list.gsp to views/song/<new-name>.gsp

Preview of a method rename refactoring, including some changes added by the Grails Aware

Refactoring Participant:

Rename Method X

Changes to be performed

¢ @

-,
v
S

@3 show.gsp - gTunez/grails-app/views/song
@ create.gsp - gTunez/grails-app/views/song
@1,3 edit.gsp - gTunez/grails-app/views/song
v ::B
P ® songController
P @ Rename Grails Controller Action Participant other changes

[J] songController.groovy

Original Source

Refactored Source

“import org.springframework.dao.DataIntegrityViolation
:class SongController {

static allowedMethods = [save: "POST", update: "P

def index() {

redirect(action: "list", params: params)
; |_\[

def list() { |

params.max = Math.min(params.max ? params.int
[songInstancelList: Song.list(params), songIns

}

def create() {
IsonaInstance: new Sona(params)]

pacrayc gouncs y-
import org.springframework.dao.DatalntegrityViol :
- T -
(=]
-class SongController { |
static allowedMethods = [save: "POST", updat
def index() { =]
redirect(action: “"showall", params: paral
)] ’ =
def showall() {
params.max = Math.min(params.max ? param
[songInstancelList: Song.list(params), so o
} =
def create() { E

[<] 1

! |
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A refactoring participant performing the same kinds of changes is also triggered when a view
(gsp file] is renamed.

belongsTo, hasOne, hasMany inferencing support

References to fields implicitly defined in the belongsTo, hasOne, and hasMany domain class
fields are now available to the editor in confent assist and type inferencing. This feature works

best in Grails 2.0.0.M2 and later, but is still somewhat supported in 2.0.0.M1.

As an example, the Person domain class has an implicit Pets field, which is visible in the
associated PersonController class:

class Person {
static hasMany = [pets:Pet]
}

= def create() {
new Person( ).petk

Per;on.pet;’
Provided by Grails hasMany

[personInstance I new

Unit Testing DSL (Grails 2.0.0.M2 or later)

Many parts of the new Crails unit testing DSL and idioms are available for content assist and
inferencing.  For example, the type of the value inside the @TestFor annotation is used as the
type of the controller field when testing controller classes:

@Mock(Person)
@TestFor(PersonController)
class PersonControllerTests {
E void testIndex() {

controiler. index()
PersoiiController PersonControllerTests.controller
‘The controller class under test

}
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Grails 2.0 stack trace support

The new format for Grails stack traces, as described here:

http://grails.org/doc/2.0.0.M1/guide/infroduction. himl#developmentEnvironmentFeatures

is now correctly handled in the console. The references are hyperlinked and clicking on them
will navigate you fo the expected line number in the expected file:

‘e

13E def list() {

14 throw new Exception("Why???")

15 .max = Math.min( .max ? .int('max')
16 [personInstancelist: Person.list( ), personlnstanc

17 3

El Console 3 [0 Markers | =; Progress | €] Error Log |
5TS 2.8.0.M2 with Grails 2.0.0.M2 (run-app) [Grails] /System/Library/Java/JavaVirtL
Runmony oruoes wppoccwervoe e

| Server running. Browse to http://localhost:8888/5752.8.9.M2
| Error 2011-09-16 12:14:29,560 ["http-bio-8080"-exec-10] ERROR error:
Nhy???. Stacktrace follows:
Line | Method
->> 14 | list in com.smgé%;rce.st5280m2.PersonControHer

| 886 | runTask in java.util.concurrent.ThreadPoolExecutor$Worker
8 | run . . in v

" 689 | run in javajang.Thread
Navigation support for URL mappings (STS-599)

Controlclick navigation is now available in the UrlMappings.groovy file. It is possible to
navigate from a mapping declaration to the view, controller, or action that it corresponds to. For

example CTRLClick (or CMD-Click on Macs| on create:

class UrlMappings {

static mappings = {

"/%$gnu?" (controller: 'person', action: cwte')
}

r

Will navigate you to the create action in the PersonController class:

def createf) {
[personlnstance: new Person( )]
}
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Better content assist for dynamic finders

Validation of Grails dynamic finders will now recognize domain properties coming from abstract
domain classes. In the following example, notice how the dynamic finder refers to the name
property of the Person domain class:

= [€) Person.groovy - STS 2.8.0.M2 with Grails 2.0.0.M2/grails-app/dom

package com.springsource.sts280m2

1

2

3 abstract clg Person {
4 Strin

5}

6

2
2 class Vet extends Person {

4 String specialty

5 static spegi a riny e ring specialty) {
6 Vetf. findBySpecial tyAndNameEquals(specialty, name)
7 }

8}

Also, content assist for dynamic finders will now propose method completions where

appropriate:

Vet—.Finde-S»gecialéyAndN;mell ' S o

o* findBySpecialtyAndNamelnList : Vet - Vet (GORM)

o* findBySpecialtyAndNamelsNotNull : Vet - Vet (GORM)

o* findBySpecialtyAndNamelsNull : Vet - Vet (GORM)

& findBySpecialtyAndNamellike(Object specialty, String name) : Vet - Vet (CORM)
& findBySpecialtyAndNamelnList(Object specialty, List name) : Vet - Vet (CORM)
osfindBySpeciaItyAndNamelsNotNuIl(Object specialty) : Vet - Vet (CORM)

& findBySpecialtyAndNamelsNull(Object specialty) : Vet - Vet (GORM)

Crails 2.0.0.M2 and later provide a command that allows downloading source code for jars in
'Grails Dependencies' (works only if the source jars are indeed resolvable through ivy). STS
makes use of this command to provide a 'Download source atfachments' menu item.

ElE6E > Disable Dependency Management
| = ‘ *
1 Compa Wit > Refresh Dependencies Alt+GR |
Restore from Local History..
Groovy Type Checking > Grails Command Wizard... Alt+G W ,
Spring Tools > Open Grails Command Prompt Shift+Ctri+Alt+G |
Gradle > )
Groovy > Create Taglib... Alt+G AIt+T |
Create Filters... Alt+G Alt+1 =
Source >
Create Service... Alt+G Alt+S
Configure >
= Create Controller... Alt+G Alt+C
Properties Alt+Enter Create Domain Class... Alt+G Alt+D
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There is now a DSL descriptor shipped with Grails 2.0.0.  This provides extra editing support

when working with Grails artifacts. For example:

Grails constraints DSL (STS-1184)
Full content assist for the standard constraints block:

class User {

String firstName
String lastName
Date dob

static constraints = {
dob

&’ dob(Boolean unique) : Object - User (Grails Constraints DSL)
} &° dob(Boolean nullable) : Object - User (Grails Constraints DSL)

&° dob(Date max) : Object - User (Grails Constraints DSL)

&° dob(Date min) : Object - User (Grails Constraints DSL)

&’ dob(Integer size) : Object - User (Grails Constraints DSL)

&° dob(List inList) : Object - User (Grails Constraints DSL)

&° dob(Object notEqual) : Object - User (Grails Constraints DSL)

&° dob(Range range) : Object - User (Grails Constraints DSL)

Invoking content assist inside of a constraint method, you can see the method context information

displayed:

Date dob

static - 1

dob()

GORM criteria query support (STS-580)
There is now editing support for the criteria query builder DSL in the Groovy Editor:

def userQuery() {
withCriteria {
and {
between('dob', new Date(), new Date().minus(1000))
eq("lastName", "Smith")
{3}

} } ibernateCriteriaBuilder HibernateCriteriaBuilder.or(Closure components)
} Provided by Criteria builder DSL
Grails ORM DSL support

There is now full support for the Grails ORM DSL in the static mapping field of a domain class:

static mapping = {
ca

} A cache(Boolean shouldCache) : void - User (Grails ORM DSL)
a &° cache(String usage, String include) : void - User (Grails ORM DSL)
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static mapping = {
ta
}  a’table(String tableName) : void - User (Grails ORM DSL)
o 4’ tablePerHierarchy(Boolean val) : void - User (Grails ORM DSL)

STS now has more complete support for dynamic finders.

Navigation to referenced controller or action in g:link tag

Pressing F3 or Chilhover over an action/controller in a g:link tag will navigate you to the

definition of that action/controller:

138 <ul>
14 <li><a class="home" href="${createLink(uri: '/')}"><g:message code="default.home.label"/></a></11>
15 <li><g:link class="create" action="create"><g:message code="default.new.label" args="[entityName]" /></g:link></11>
= — /(he me of the action to use in the link, if not specified the default action will be linked,
, | Press 'F2' for fOCUS
2 ’UsefC°“1f0||ef~9WaiIs—app/controllers/com/springsource/sts !
5 class UserContr r{
6B def create() {
7 [userInstance: new User( N
8 }
9

Content assist in g:link tags

There is now content assist for relevant controllers and actions in g:link tags:

<li><a class="home" href="%{createLink(uri: '/')}"><g:message code="default.
<liz<g:link class="create" action-'1"><g:message code="default.new. label" arg
1> &4 create (action in user controller)
&4 delete (action in user controller)

groovy - sts280M1/grails-app/controlle &1 edit (action in user controller)

&4 index (action in user controller)
roller { . L
O { &4 list (action in user controller)
nstance: new User( b} | &4 save (action in user controller)

&4 show (action in user controller)
&4 update (action in user controller)
@ actionSubmit

)y { @ actionSubmitimage

allowedMethods = [ : "POST", upd

~ A mmaaled aime

Gradle Tools

Cerfain key import wizard preferences are now persisted inside the Gradle project root .seffings
folder. The seftings that are being persisted are:

* The list of projects imported info STS
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NEW AND NOTEWORTHY

* seftings related to running specific tasks before/after importing.

The settings file is found under:

<root-project-folder>/.settings/com.springsource.sts.gradle.core.import.prefs

Though the file is not infended to be edited directly by the user, it should be safe to share among
users via source control. The entries in the file are represented in such a way as to retain their
meaning relative to the root of the project hierarchy.

Comments and feedback about this feature [specifically ideas from a user's perspective) about
whether or not certain preferences should or should not be made shareable in this way are
welcome and encouraged. Please raise an SIS Jira issue  or comment on
https: //issuetracker.springsource.com/browse/STS-2106 to provide your input.

The import wizard now handles many common problems that may occur because of pre-existing
and conlflicting eclipse configuration files. The wizard only touches those aspects of a project's
configuration that are related to what it understands (java nature, jar dependencies, project
dependencies, source folders...]. Other configuration in#ormoﬂon, such as other project natures

and their related settings are, as much as possible, left infact.

This makes it possible to correctly import project types beyond just the 'pure Java' projects that
are supported directly by the current version of the Gradle Tooling API. The generated files, in
many cases, can provide the missing configuration information that is needed to make the
projects work.

The wizard now provides options to run tasks before and/or affer projects are imported into the
WorksEoce. The infention for these options is to allow the user to customize projects, for example,
to make up for lacking support or bugs in the current version of the tooling APl or the STS Tool
support.

A common use case is fo execute the 'cleanEclipse’ and 'eclipse' tasks on the project before
importing. This works well in combination with the fact that the wizard now is beffer at dealing
with pre-existing Eclipse configuration files.

The before tasks will be executed on all projects that define them, before any projects are
imported.

The affer tasks will be executed on all projects that define them, after all projects have been
imported.

Warning: with Gradle M3 it is not possible for STS to determine whether the cleanEclipse and
eclipse tasks are defined on a project. See GRADLE-1792 for defails. Because of this, the option
will be disabled by default for pre M4 projects. You can still use the option with an M3 build by

explicitly enabling it. However, you must ensure that all the projects you want to import
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effectively have the eclipse tasks defined on them. Otherwise execution of the tasks will fail
without any tasks being executed.

Note that the default affer task, 'afterEclipselmport' is not a builtin Gradle eclipse task. It is purely
infended as a hook for you to plugin any custom post processing you may want fo do.

Other minor tweaks:

 'Use Hierachical Project Names' is now deselected by default, because the flat' naming
scheme seems to correspond more to what most people would expect and want.
* Projects in the tree-viewer are now sorted alphabetically.

The new import wizard looks like this:

Import Gradle Project == S ;

Root folder: | /home/kdvolder/commandline-dev/spring-security [Bmwse...l [Build Modell

-~

Project Description —

S spring-security-ldap

S spring-security-openid

S spring-security-remoting

S spring-security-samples-aspectj

S spring-security-samples-cassample
S spring-security-samples-casserver

S spring-security-samples-contacts
S spring-security-samples-dms

0000000 ®

S spring-security-samples-gae

D S spring-security-samples-ldap

G cnrinn.securitbv.samnles.anenid )

Auto-select subprojects

‘ Select All ] [ Deselect All I ISelect Required]

-Import optior
[cleanEcIipse eclipse ] Run after | afterEclipselmport
Create resource filters [[J Use hierarchical project names

Create workingset 'spring-security’

-Additional working sets

[C] Add project to working sets
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Alfhou?h the Gradle Tooling APl does not yet provide any support for WTP Web projects, it is

possible now fo get limited support in STS by relying on running the cleanEclipse and eclipse
fask before importing projects into STS.

When WIP projects are imported and the eclipse task has been executed beforehand, STS
recognizes their WTP nature and performs some customizations specific to WTP projects:

* The classpath container containing the 'Gradle Dependencies' is added to the
Deployment Assembly .

* Specific items in the classpath container that should not be deployed are recognized and
excluded.

The set of items to be excluded can be configured from a preferences page: Preferences >>

Gradle >> WTP :

[Epetirs 1) wre G D v
P General [~]
b Ant Gradle Dependencies Deployment Exclusions
) serviet-api-.*\.jar B
Aspect] Compiler = javax.serviet-api-*\.jar 5
Atlassian Connector isp-api-*\.jar
P Data Management
v Gradle | |
P Groovy
P Help
P Install/Update ||
b Jave @ Dl
D JavaEE v
b = —] |Restore Qefaultsl | Apply l
(<] Il [>]
@ | Cancel ‘ l r\OK ]
L s

Note 1: The default setup avoids common problems that are known to cause failure to deploy @
project.

Note 2: This is a temporary solution. A proper implementation would exclude dependencies from
deployment based on Gradle configuration types (e.g. test and provided dependencies should
be excluded). However, the needed information is not provided by the current version of the
Cradle Tooling API (see issue GRADLE-1777). In the mean time, this Yist of exclusions will help to
deploy more Gradle WTP projects successfully. Suggestions to add more patterns to the deE]uH
exclusion list are welcome.

In some cases, a Gradle model build may fail because the tooling APl is not able to defermine
correctly what version of Gradle it should be using for your project. When a model build fails,
STS will propose to try using M3 which seems, presently, to be the most stable and widely used
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version of Gradle. If the option is accepted, this choice will be persisted as a workspace
preference so that all further model builds will use M3. (To cancel this, use the Gradle
Preferences page to switch back to using the "Gradle Wrapper's Default').

Aspect]/AIDT

AIDT now includes a release candidate build of Aspect] 1.6.12. In this build two options have
been turned to ON by default (minimalModel and typeDemotion).  Previously these options
defaulted to OFF.  These options should lead to a reduction in memory footprint for Aspect]
projects [e.g. Roo projects) in your workspace.

If you have any issues after upgrading, the settings can be turned off by specifying

—Xset:minimalModel=false, typeDemotion=false
in the project properties (in non-standard compiler options).
The release notes for Aspect] 1.6.12 are here:

http:/ /www .eclipse.org/aspectj/doc/released /README-1612. himl

Fixed Bugs and Enhancement Requests

Here is a full list of resolved bugs and enhancement requests for the 2.8.0 release:

STS Issue-Tracker:

https: / /issuetracker.springsource.com/ secure/IssueNavigator. jspa@reset=true&{glQuery=project
+%3D+STS+AND+HixVersion+in+%2811782%2C+11188%2C+11781%2C+11187%2C+11
185%2C+11184%29+AND+status+in+%28Resolved% 2C+Closed %29

Spring IDE Issue-Tracker:

https: //jira.springsource.org/secure/ IssueNavigator. jspa2reset=true&iglQuery=project+% 3D+
DE+AND-+ixVersion+in+%2812615%2C+12216%2C+12614%2C+12215%2C+12213%2
C+12212%29+AND+status+in+%28Resolved%2C+Closed% 29
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